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Welcome!
Thank you for choosing Reason!

Reason 13 is focused on workflow and sounds. Reason 13 features an upgraded sequencer, a brand new 
browser, five new devices, and more sounds.

All patches, samples, and loops are now in one place—the new Browser. Find the perfect sound by 
filtering on anything from name and kind to categories and tags. Just type what you’re looking for and the 
Browser will give you suggestions. All content in Reason is now manually categorized and tagged. That 
includes all sound banks, all Reason Studios devices, and all Sound Packs. You can also tag your own 
sounds if you like. In Reason 13.3 you can also choose to place the Browser in the side panel to the left in 
the document window.

The Sequencer has been split into two. With the new Edit Area it’s easy edit the details in your music 
without losing your way in the arrangement. Several new workflow improvements, improved zooming, 
layout changes, and easy access to editing features, makes it a lot easier to create and edit your music.

Polytone Dual-Layer Synthesizer is inspired by our favorite vintage hardware synths. We designed it to 
recreate the warm analog sounds you know and love. But it wouldn’t be us if we didn’t tweak the formula 
for more possibilities. Polytone has two layers that can be stacked or morphed between for super fat or 
evolving sounds.

Ripley Space Delay combines delay and reverb with unique flavors of filtering, noise, and distortion. 
Coupled with extensive modulation you can create the delay you want—anything from clean taps or warm 
analog sounds to crazy lo-fi chirps or washed out ambience. Everything that adds character and depth to 
your music.

Reason 13 also comes with three new Tool devices that simplify common tasks for a smoother workflow:

Sidechain Tool is all about ducking signals. Use Auto Pump for that classic four-on-the-floor pumping, 
trigger to play the rhythm via MIDI, or use the traditional Sidechain mode for classic sidechain 
compression.

Gain Tool puts you in control over signal levels, stereo panning, and routing in one sleek package. Perfect 
for automation, auditioning, or using in a Combinator. Also perfect for use with Reason Rack Plugin!

Stereo Tool is a stereo widener specifically designed to make a simple signal sound bigger and wider, 
without any phase problems. Perfect for giving that old mono synth or vocal track new life.

The Reason 13.1 update also brings two new Player devices: Note Tool and Random Tool—perfect for 
manipulating MIDI notes in various ways. Reason 13.1 also lets you customize the Device Palette and 
what’s displayed in the Browser, using custom Tags.

Like the previous versions, Reason 13 also lets you use Reason Rack Plugin as a plugin in another 
VST3/AU/AAX compatible DAW.

Don't forget to visit the Reason Studios web site at www.reasonstudios.com and read up on all the new 
Rack Extension instruments and effects created by ourselves and others that you can add to your rack.

Yours truly,

The Reason Studios Team

www.reasonstudios.com

http://www.reasonstudios.com
http://www.reasonstudios.com
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About the Reason documentation
This is the Installation Manual where installation of Reason and basic setting up procedures are described. 
Detailed features and operations in Reason are described in the Operation Manual pdf and in the on-line 
Help system. The Operation Manual and Help also contain reference descriptions of all Reason devices 
and commands.

About operating system versions
Reason runs under macOS and Windows (for operating system details, see “Requirements”) and only 
supports 64-bit operating system versions. All Reason packages contain program versions for both 
platforms. Everything said in the manuals applies to both platforms, unless explicitly stated.

Registering Reason (licensed 
version only)
To be able to run your licensed version of Reason 13, the program must be registered to your account on 
the Reason Studios web site.

D If you purchased a Reason license in a music store, follow the instructions you received 
from the shop.

! If you purchased Reason directly from the Reason Studios Shop web site, the Reason li-
cense has already been automatically registered to your user account and you can use 
Reason by running it on a computer connected to the Internet.

The Reason download
The full Reason download contains the complete product contents. When you have downloaded the 
program package via the Reason Companion application (see “Installing the Software”) and installed the 
program, all you have to do is register (licensed version only) Reason and you are good to go.

! If you are using Reason as part of a Reason+ subscription you can download Reason via 
the Reason Companion application. You don’t have to register anything; just launch Rea-
son and log in using your Reason Studios User name and Password.
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Requirements
Below you will find the minimum requirements for running Reason 13:

! Note that these are the minimum requirements! You will benefit from a fast computer 
with lots of RAM, since this will allow you to use more devices at the same time.

macOS
• Fast and stable Internet connection for installation and registration required!
• Apple Silicon or Intel Mac with multi-core processor
• 4 GB RAM (8 GB or more recommended for large ReFills or Rack Extensions)
• 6.5 GB free system disk space required, plus 8 GB for optional content (and another 12 

GB if you are using Reason+). Additionally, the program may use up to 20 GB scratch disk 
space

• macOS 10.15 (Catalina) or later (64-bit)
• Monitor with at least 1280x768 resolution
• CoreAudio compliant audio interface or built-in audio hardware
• MIDI interface and a MIDI keyboard recommended
• For using Reason as a Plugin, a DAW host with VST3/AUv2/AAX support is required

Windows
• Fast, stable Internet connection for installation and registration required!
• Intel or AMD multi-core processor - or a Windows on Arm computer with Prism emulation 

software
• 4 GB RAM (8 GB or more recommended for large ReFills or Rack Extensions)
• 6.5 GB free system disk space required, plus 8 GB for optional content (and another 12 

GB if you are using Reason+). Additionally, the program may use up to 20 GB scratch disk 
space

• Windows 10/11 (64-bit)
• Monitor with at least 1280x768 resolution
• Audio Interface with ASIO driver
• MIDI interface and a MIDI keyboard recommended
• For using Reason as a Plugin, a DAW host with VST3/AAX support is required
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About the Audio Hardware
! If you are running Reason Rack Plugin, all audio inputs and outputs are handled by the 

DAW host - refer to the manual for your specific DAW.

The audio hardware is the computer equipment that converts the analog signals from instruments and 
microphones to digital signals that Reason can work with and store, and back again (for connection to an 
amplifier, headphones, or similar). This equipment could be a built-in audio card, a 2 channel USB 
interface, or a Firewire audio interface, or an audio card with several inputs and outputs, digital connectors, 
etc. Regardless of which, you need to make sure the hardware and its drivers are properly installed:

Audio hardware and macOS

If you are using the built-in audio hardware in your Macintosh

All Mac models come with a built-in audio interface, providing stereo input and output jacks (and in some 
cases a built-in microphone). Depending on your needs, the quality of these inputs and outputs may be 
fully sufficient for use with Reason. 

If you are using other audio hardware with your Macintosh

You may want to use other audio hardware with Reason (e.g. an audio interface with multiple outputs, 
digital connections, etc.). For this to be possible, the audio hardware must be compatible with macOS, i.e. 
there must be a Core Audio driver available for the hardware.

1. Install the audio hardware drivers as described in its documentation.
Note that some audio hardware does not require any special audio drivers. Please, refer to the hard-
ware documentation.

2. Connect the stereo outputs of your audio hardware to your listening equipment (speak-
ers, mixer, headphones or similar).
For info about how to use multiple outputs (i.e. more than a stereo output), see the Operation Manual 
pdf. For now, we stick to standard stereo connections.

3. If possible, test that audio plays back OK with the audio hardware.
With some audio hardware, a test application is supplied for this purpose.

Audio hardware and Windows
! To run Reason with full audio in and audio out functionality under Windows, an ASIO 

driver is required for the audio hardware.

Reason can run with DirectX or MME drivers as well but this will only support audio out - and at con-
siderably higher latencies than with ASIO drivers.

1. Make sure you have the latest ASIO driver for the audio hardware!
Please check the manufacturer's web site for the latest versions.

2. Install the audio hardware drivers as described in its documentation.

3. Connect the stereo outputs of your audio hardware to your listening equipment (speak-
ers, mixer, headphones or similar).
For information about how to use multiple outputs (i.e. more than a stereo output), see the Operation 
Manual pdf. For now, we stick to standard stereo connections.

4. If possible, test that audio plays back properly with the audio hardware.
In the case of audio hardware with ASIO drivers, you will need some test application for this (often in-
cluded with the audio hardware).
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About MIDI Interfaces
While it is possible to use Reason without an external MIDI controller (by only using the “On-screen Piano 
Keys” window for playing MIDI notes, or by manually drawing notes and automation in the sequencer), this 
would not allow you to use the program to its full potential. From now on we assume that you are using a 
keyboard controller - either a USB keyboard with a built-in MIDI interface, or a separate MIDI interface and 
a MIDI keyboard.

D When installing the keyboard controller, or MIDI interface and its drivers, follow the in-
structions in its documentation carefully.

• While a MIDI interface with a single MIDI port is sufficient, you will benefit from having 
two or more individual MIDI ports.
This is especially true if you want to manipulate Reason parameters with additional MIDI control sur-
face devices, or use the program in conjunction with an external, stand-alone sequencer, drum ma-
chine or similar.

• For some MIDI interfaces connected via USB, no driver installation is required. Just plug 
in the interface and you're ready to go!

• For other, more advanced MIDI interfaces (or at least to take advantage of more ad-
vanced features, like multiple inputs) you will need to install a driver.
Please consult the documentation that came with the interface for details.

MIDI In Connections
D Simply connect the USB cable from your keyboard to your computer.

Or

D Connect a MIDI cable from the MIDI Out on your MIDI keyboard (or other MIDI controller) 
to a MIDI In on your MIDI interface.
This is sufficient to be able to play and record notes and controllers in Reason from the MIDI keyboard.

• If you are not using a USB keyboard, you may also connect the MIDI Out from the MIDI in-
terface to the MIDI In on your MIDI keyboard.
This is not strictly necessary to use Reason, but it will enable two-way communication when you run 
the Reason Setup Wizard which appears the first time Reason is launched (see “First run - Reason 
Setup Wizard”), or when using Auto-detect Surfaces in the Preferences (see “Adding a specific Con-
trol surface”). Whether auto-detection works or not depends on the keyboard model.

! If you have several MIDI control surfaces or similar that you want to use, we recommend 
that you connect them to separate MIDI ports (or directly to the computer using USB).

MIDI Out Connections
If you have external synthesizers, drum machines or other devices that can be played via MIDI, you can 
control them from Reason. For this you need to have a MIDI interface with one or several outputs. 

D Connect a MIDI cable from a MIDi Out jack on the MIDI interface to the MIDI In jack on 
your external instrument.
Read more about how to control external MIDI devices from Reason in the Reason Operation 
Manual.pdf or Reason Help in the program.
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Installing the Software
! Both the standalone version of Reason and Reason Rack Plugin are installed in the same 

procedure. So, even if you are only planning to use the Reason Rack Plugin, follow the in-
stallation procedure(s) below:

Installing Reason
1. If you haven’t already, download and install the Reason Companion application at 

www.reasonstudios.com/download-reason-companion.
Reason Companion is required for downloading Reason 13.

2. Launch the Reason Companion app and click the “My Reason” tab down to the left:

3. On the “My Reason” tab, click the “Download Reason 13” button:

4. Unzip the download file (Windows) or mount the disk image file (macOS).
What to do next depends on whether you are installing on a Mac or a Windows computer.

Windows:

1. Locate the file called “Install Reason 13.exe" and double click it.

2. Follow the instructions on screen.
Before executing the installation of the software components, you will be asked to select a language, 
an install location, and whether you wish to create a program shortcut/alias on your desktop. When the 
installation is complete, you have the option of launching Reason directly.

The Reason Rack Plugin VST3 is automatically installed in 
C:\Program Files\Common Files\VST3.

The Reason Rack Plugin AAX is automatically installed in 
C:\Program Files\Common Files\Avid\Audio\Plug-Ins\

https://www.reasonstudios.com/download-reason-companion
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macOS:

1. Double click the Reason installation file.

2. Follow the instructions on screen.
The Reason Rack Plugin VST3 is automatically installed in 
Macintosh HD/Library/Audio/Plug-Ins/VST3.

The Reason Rack Plugin AUv2 is automatically installed in 
Macintosh HD/Library/Audio/Plug-Ins/Components.

The Reason Rack Plugin AAX is automatically installed in 
Macintosh HD/Library/Application Support/Avid/Audio/Plug-Ins

Both platforms:

Reason comes with some additional content (Rack Extensions and ReFills) that you can download 
separately, either right after the Reason installation or at a later point. To download additional content, 
proceed as follows:

1. In the Reason Companion app click the Devices tab.

2. At the top of the Devices tab, install the desired additional Rack Extension device(s).
Alternatively, click the “Install All” button to install all Rack Extensions in one go:

3. Then, click the “ReFills” tab and install the desired additional ReFill(s).
Alternatively, click the “Install All” button to install all ReFills in one go:

4. After installation, (re)start Reason for the installed items to become available.
The additional content is stored on your computer as follows: 

• The additional Rack Extension devices are stored in the following folders:
Windows: C:\Users\[your.user]\AppData\Roaming\Propellerhead Software\Optional REs
macOS: ~/Library/Application Support/Propellerhead Software/Optional REs

• The additional ReFills are stored in the “Music > Reason Studios > ReFills” sub-folder.
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About this Chapter
! This chapter is only relevant for the stand-alone version of Reason. For Reason Rack 

Plugin, no further setup is needed as the host DAW handles audio and MIDI connections.

This chapter describes the settings you need to make before you can start using the stand-alone version 
of Reason. These are necessary in order to get any sounds to and from the program and to be able to play 
and control Reason via MIDI.

First run - Reason Setup Wizard
If you followed the instructions correctly in the last chapter, Reason should be running, and the first dialog 
in the “Reason Setup Wizard” guide should be open. 

This only appears the very first time the program is run.

! Note that the Language page only appears in the Windows version of Reason. 
In macOS, the selected system language is used.

! Note that any setting you make in the Setup Wizard can be changed later on in the Pref-
erences dialog.

D Clicking “Next” will take you through a series of dialogs, where the following happens:
• The Setup Wizard will first try to find a compatible audio driver.

It will automatically select the first compatible driver it finds. If this is the driver you wish to use, fine. If 
it isn't, select your preferred driver from the Audio Card Driver pop-up. If you don't know which driver to 
use, see “Setting up the Audio Hardware”.

• Next, Reason will try to auto-detect a Master Keyboard.
If one is found, click "Next" to proceed.

! For Reason to auto-detect a device you need two-way MIDI communication! Non-USB 
keyboard devices without a MIDI input can of course still be added manually.
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! Note that your keyboard model might not be auto-detected by Reason, even though it’s a 
modern one and connects via USB. However, you can still use such a keyboard to control 
Reason in the same way as with an auto-detected keyboard.

D Note that if you have additional remote control surface devices in your setup, these might 
have to be added in the Preferences - see “Adding a specific Control surface”.
The Setup Wizard will only establish a connected Master Keyboard device.

Setup is now complete!

If all went well, you should now have established audio and MIDI communication - the basics needed to 
record and play back audio and for controlling Reason via MIDI!

However, if for any reason the Setup Wizard failed to establish the necessary settings, or if you wish to add 
other devices etc., you will have to make your settings in the Preferences dialog (see below).
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About the Preferences
The basic settings for audio and MIDI are done in the Preferences dialog. This is opened from the Edit 
menu (or, if you are running macOS, from the Reason menu). 

The “User Interface” tab in the Preferences dialog.

q Described herein are only the most important settings in the Preferences. For informa-
tion about other Preferences settings, see the “Menu and Dialog Reference” chapter in 
the Reason Operation Manual pdf.
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Setting up the Audio Hardware
In case this wasn't done in the Setup Wizard, you need to establish a connection between Reason and the 
audio hardware. This is done by selecting a driver - a software component that acts like a link between the 
program and the audio hardware. Proceed as follows:

1. In the Preferences dialog, click the Audio tab.

2. Click the Audio Device selector and select one of the available audio drivers.
Which driver to select depends on the platform and the audio hardware. If an option is not applicable to 
your setup it will be disabled in the dialog.

macOS

D Select the option that corresponds to the hardware you want to use (the built-in audio 
connectors or some additional audio hardware that you have installed).

q A number of predefined combinations of built-in inputs and outputs will also be available 
in the Audio Device list.
The number of available input(s)+output(s) combinations depends of your computer’s specific audio 
hardware configuration.
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Windows

! If you run Reason under Windows, it’s required that the audio hardware supports ASIO 
drivers, otherwise you won’t be able to record any audio.

D Select the option that corresponds to the ASIO hardware you want to use.
If you are using audio hardware for which there is a specific ASIO driver, you should select this.
With an ASIO driver written specifically for the audio hardware, Reason can communicate more or less 
directly with the audio hardware. The benefits are lower latency (see below) and possibly better sup-
port for additional hardware features such as multiple inputs and outputs.

About Latency and other Audio Settings

On the Audio tab, you will find a number of additional settings for audio. The most important ones are 
Buffer Size and the corresponding readouts for Input and Output Latency. 

The Input Latency is the delay between when the audio is “sent” from a connected microphone or 
instrument and when it’s received and detected by Reason. Output Latency is the delay between when 
audio is “sent” from Reason and when you actually hear it. The latencies in an audio system depends on 
your audio hardware, its drivers and their settings.

When you select a driver, its latency values are automatically reported by the audio card and displayed in 
the on the Audio tab in Preferences. Depending on the audio hardware and the driver, you may be able to 
adjust these values. If you experience high latency values, you will need to make adjustments to your 
configuration. 

D If available, drag the Buffer Size slider the left to lower the latency.
The lowest buffer size setting you can choose depends on the audio drivers and your computer's per-
formance. If you get crackles and glitches during playback, the buffer size is set too low for your sys-
tem - you need to raise the buffer size until you can play back normally.

D If the Buffer Size slider is disabled, you may be able to lower the buffer size in the control 
panel for the audio hardware - click the Control Panel button to open this.

For more information, please consult the Reason Operation Manual pdf/Help.
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Setting up MIDI Control Surfaces
In Reason, MIDI keyboards or remote control devices are called control surfaces. MIDI input from control 
surfaces can be handled by two systems: “Easy MIDI Inputs” and Remote. Here are some of the main 
features:

• You can use any number of control surfaces at the same time.
• The program supports a large number of control surfaces out of the box - knobs, faders 

and buttons on the surfaces are automatically mapped to the most useful parameters on 
the Reason devices.
You don't have to change the settings on the control surface to control different devices in Reason - if 
you change MIDI input from a ID-8 track to a Combinator track, the control surface will automatically 
adapt. You just set up your control surface once and for all for use with Reason - the program handles 
the rest!

• For control surfaces that are not natively supported at this stage, you can use generic 
drivers.
Note however, that Remote drivers for additional control surfaces will be added continuously - check 
our web page for more info.

• By default, all control surfaces follow the sequencer Master Keyboard Input.
This means that you set MIDI input to a track in the sequencer to route the control surface(s) to the 
track's device in the rack.

• You can lock a control surface to a specific device in the rack.
For example, you could have a Master Keyboard that follows MIDI input, while another control surface 
is locked to the Main Mixer. This way you can control levels and pans at all times. This is described in 
the Operation Manual.

• You can use remote overrides to map a specific control on a surface to a specific Reason 
parameter or function.
For example, you could override-map a knob or fader on your control surface to the Main Mixer's mas-
ter level fader. Or you could map buttons on your control surface to control Reason's transport (play, 
stop, record, etc.) at all times, regardless of which track has Master Keyboard Input in the sequencer. 
This is described in the Operation Manual.

• Remote also supports some control surfaces with MIDI feedback.
If you have such a control surface and it is supported by Reason, you can take full advantage of motor-
ized faders, meters, displays, etc.

In case you specified a Master Keyboard in the Setup Wizard, and you don't have any other control 
surfaces, you don't have to do anything else. But if you want to add additional control surfaces or edit your 
settings, this is done in the Preferences.

Automatic set-up using the Easy MIDI Inputs function
By default Reason automatically scans and detects all available MIDI In port(s) on your computer. If you 
have a MIDI keyboard or MIDI control surface connected to your computer, Reason automatically connects 
and lets you use it for controlling Reason. This way you don’t have to do any manual set-up but can start 
controlling Reason right away.
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At the bottom of the MIDI tab in Preferences all currently available MIDI In Ports are listed:

All available MIDI In Ports on your computer are listed in the Easy MIDI Inputs list.

• The Easy MIDI Inputs function supports input of MIDI Note On/Off (with Velocity) as well 
as standard performance controllers, such as Mod Wheel, Pitch Bend and Sustain Pedal.
You can also do manual Remote Overrides to assign Reason parameters to knobs/sliders/buttons on 
your control keyboard/surface. See the Remote chapter in the Operation Manual for more information.

D Deselect the Enabled box(es) to disable MIDI Ports you don’t want to be available for 
Reason.
For example, if you have a drum machine connected via USB to your computer, you might not want it 
to start sending MIDI Note data to Reason, especially if it’s synced to MIDI Clock to Reason’s se-
quencer.

Adding a specific Control surface
If your specific MIDI keyboard/control surface model is featured in the list of supported surfaces in 
Reason you will get even more functionality if you add it in the “Remote keyboards and control surfaces” 
section at the top - with knobs/sliders/buttons already pre-assigned to parameters in Reason.

1. Open the Preferences dialog and click the MIDI tab.

2. If your control surface is connected via USB (or if you have made a two-way MIDI connec-
tion), try clicking the Auto-detect Surfaces button.
Reason sends an ID request to all MIDI ports and checks for answers from any connected control sur-
faces. Note that not all control surfaces support auto-detection.
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! If a MIDI Port of your connected control surface/keyboard is already used by the Easy 
MIDI Inputs function (see “Automatic set-up using the Easy MIDI Inputs function”), this detection 
will override this and automatically remove the MIDI In Port from the Easy MIDI Inputs 
list.

All found surfaces are listed in the “MIDI Keyboards / Controller” list. 

3. To add a control surface manually, click the “Add manually” button.
This brings up a new dialog.

4. Select the manufacturer of your control surface from the Manufacturer pop-up menu.
If you can't find it on the menu, see below.

5. Select the model of your control surface from the Model pop-up menu.
If you can't find it on the menu, see below.
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6. An image of the selected control surface model is shown, often along with some informa-
tion text - read this carefully.
For some control surfaces, you need to select a specific preset to use the surface with Reason - this 
is noted here.

7. Use the MIDI Input pop-up to select the input port to which you have connected the sur-
face.
If in doubt, you can click the Find button and then tweak a control or play a key on the control surface 
to have Reason find the correct input port for you.

• Some control surfaces may have more than one MIDI Input pop-up menu.
You need to select ports on all MIDI Input pop-up menus.

• Some control surfaces will have a MIDI Output pop-up menu.
In some cases this labeled "Optional" - then you don't have to make a selection. In other cases, a MIDI 
Output is required. This is the case if the control surface uses MIDI feedback - motor fader, displays, 
etc.

8. If you like, you can rename your control surface in the Name field.

9. Click OK to add the surface.
• Depending on the surface model, alerts may appear, reminding you to select a specific 

preset etc.
In some cases, Reason can restore a preset in the control surface to factory settings for you - you are 
then informed of this.

Finally you return to the MIDI tab in Preferences, where your added surface is now listed.
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If your control surface model isn't listed

If you can't find your control surface listed on the Manufacturer or Model pop-up menus when you try to 
add it, this means that there's no native support for that model. However, the program supports generic 
keyboards and controllers. Here's what to do:

D Select "Other" on the Manufacturer pop-up menu and then select one of the four options 
on the Model pop-up menu.

Or, if the Manufacturer is listed but not your specific model:

D Select one of the four "Other" options on the Model pop-up menu:

In both cases, the options are:

• MIDI Control Keyboard 
Select this if you have a MIDI keyboard with programmable knobs, buttons or faders. You need to set 
up your MIDI control keyboard so that the controllers send the correct MIDI CC messages, depending 
on which Reason device you want to control - check out the MIDI Implementation Chart in the Reason 
documentation. If your control surface has templates or presets for different Reason devices, these 
can be used.

• MIDI Control Surface 
Select this if you have a MIDI controller with programmable knobs, buttons or faders (but without key-
board). Again, you need to set your controllers to send the correct MIDI CCs.

• MIDI Keyboard (No Controls)
Select this if you have a MIDI keyboard without programmable knobs, buttons or faders. This is used 
for playing only (including performance controllers such as pitch bend, mod wheel, etc.) - you cannot 
adjust Reason device parameters with this type of control surface.

• MIDI Multichannel Control Keyboard/Surface
These options can be used if your MIDI keyboard or surface can handle multiple MIDI channels simul-
taneously.

After selecting a model, proceed with selecting MIDI input as described above.

About the Master Keyboard

One of the control surfaces can be the Master Keyboard. This is like any other control surface, but it must 
have a keyboard and it cannot be locked to a specific Reason device (in other words, it always follows the 
MIDI input to the sequencer). This is the surface you use to play the instrument devices in Reason.

• The first surface with a keyboard that is added (or found by auto-detect) is automatically 
selected to be the Master Keyboard.
This is shown in the Attached Surfaces list on the Preferences page.

D If you want to use another surface as Master Keyboard, select it in the list and click the 
"Make Master Keyboard" button.
You can only have one Master Keyboard.

D If you don't want to use any Master Keyboard at all, select the current Master Keyboard 
surface and click the same button (which is now labeled "Use No Master Keyboard").
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Master Keyboard Input

This allows you to set a preference for how Master Keyboard Input mode is selected:

• Standard mode
This always sets Master Keyboard Input to the selected sequencer track.

• Separated mode
This will allow you to independently select tracks while Master Keyboard Input is unchanged. When 
this is mode is active, Master Keyboard Input is set by clicking the device icon in the track list. Select-
ing another track (by clicking on the track name or somewhere in the track list), leaves Master Key-
board Input unchanged.

Other functions

D To edit a surface, double-click it in the list (or select it and click Edit).
This lets you change its name and MIDI port settings, if needed.

D To delete a surface, select it in the list and click Delete.

D You can turn off a surface by deactivating its “Enabled“ checkbox.
This could be useful if the surface is connected to your system but you only want to use it with another 
program, etc.

• There is also an “Other Controls” and a “Sync” tab in the Preferences.
These are only used for External Control MIDI buses and for MIDI Clock Sync. All hands-on MIDI 
control is set up on the MIDI page.
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Setting up the Default Song
It's possible to select a default Song which will automatically open as a “template” each time you select 
“New” from the File menu. The Default Song could be any Song you have created earlier, or a factory made 
Template Song. You can select this Default Song on the “Browsing” tab in Preferences. 

1. Select “Preferences” from the Edit menu (Win) or “Reason“ menu (Mac) and then click 
the “Browsing” tab.

2. Click the "Template" radio button in the "Default Song" section. 

3. Click the Browse button to the right and select the Song you want to use as template 
when creating new Songs.
The Template Songs that come with Reason 13 can be found in your local Music folder at:
Music/Reason Studios/Template Songs/Reason 13.

Each time you create a new Song (by selecting "New" from the File menu), the selected Song will be 
loaded and used as a template for your new Song. On Windows platforms, the Song document will be 
named "Document n" where "n" is an incremental number. On macOS platforms, the document will be 
named "untitled n" where "n" is an incremental number. You can then save your Song with a new 
name.

Opening the last Song at program launch 
It's possible to instruct Reason to automatically open the last Song each time you launch Reason. You 
select this on the “Browsing” tab in the Preferences dialog. 

1. Select “Preferences” from the Edit menu (Win) or "Reason" menu (Mac) and then click 
the “Browsing” tab. 

2. Tick the "Open last song on startup" checkbox. 
When you launch Reason the next time, the last saved Song will automatically open in a document 
window.
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Reassigning the Function Keys in 
macOS
When you work with Reason, you will do a lot of navigating between the three main areas - the main mixer, 
the rack and the sequencer. The quickest way to switch between these areas is to use the function keys 
F5, F6 and F7 (see “Navigating between the areas” in the “Common Operations and Concepts” chapter in 
the Operation Manual and Help system for details). Also, the F2, F3, F4 and F8 keys are shortcuts for 
showing and hiding the Spectrum EQ window, Browser, On-screen Piano Keys window and the Tool 
Window, respectively.

However, on many Macintosh models (especially MacBooks), the function keys double as hardware 
control buttons. For example, they might control the volume of the built-in speaker, the display brightness 
or keyboard backlight. To make these keys actually work as function keys for software such as Reason, 
you need to hold the "Fn" key while pressing them.

This can work perfectly OK, but to get the best workflow in Reason we recommend that you change this 
behavior, so that pressing e.g. the F5 key actually sends "F5" to Reason (and you hold down the Fn key to 
get the hardware control functions instead). Here is how you change this:

1. Open the System Preferences in macOS and select the "Keyboard" item.

2. Click the “Keyboard Shortcuts...” button:
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3. Select the "Function Keys" tab and make sure "Use F1, F2, etc. keys as standard function 
keys" is switched on.
Now you can use F2-F8 for controlling functions in Reason. To use hardware control features such as 
volume and display brightness, you need to hold down the "Fn" key before pressing the function keys.

Some function keys might also be pre-assigned to macOS keyboard shortcuts, which will have priority over 
software such as Reason. This is easily changed:

4. Select the “Accessibility” tab.
The Accessibility window shows lists of keyboard shortcuts assigned to system functions. For exam-
ple, [Cmd]-[F5] is assigned to turn VoiceOver on or off. In Reason, this is the keyboard shortcut for de-
taching the main mixer into a separate window.

5. Either remove the tick from the checkbox or assign it to another keyboard shortcut.

6. Now you’re finished with the settings and can exit System Preferences.
From now on, the function keys and keyboard shortcuts will perform their intended functions in Rea-
son.



SETTING UP32


	Table of Contents
	Introduction
	Welcome!
	About the Reason documentation
	About operating system versions
	Registering Reason (licensed version only)
	The Reason download

	Installation
	Requirements
	macOS
	Windows

	About the Audio Hardware
	Audio hardware and macOS
	If you are using the built-in audio hardware in your Macintosh
	If you are using other audio hardware with your Macintosh

	Audio hardware and Windows

	About MIDI Interfaces
	MIDI In Connections
	MIDI Out Connections

	Installing the Software
	Installing Reason
	Windows:
	macOS:
	Both platforms:



	Setting Up
	About this Chapter
	First run - Reason Setup Wizard
	About the Preferences
	Setting up the Audio Hardware
	macOS
	Windows
	About Latency and other Audio Settings


	Setting up MIDI Control Surfaces
	Automatic set-up using the Easy MIDI Inputs function
	Adding a specific Control surface
	If your control surface model isn't listed
	About the Master Keyboard
	Master Keyboard Input
	Other functions


	Setting up the Default Song
	Opening the last Song at program launch

	Reassigning the Function Keys in macOS


